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1 Welcome to AIMM  

This help document will assist you in exploring the functionality of the AIMM program.  You 
can browse the document or use the Index or Table of Contents to find the information you 
need.   

 

2 Introduction 

Technological developments within the irrigation industry have advanced significantly over 
the last few decades. Many of these developments have resulted in on-going improvements 
to water use efficiency, increased production, higher quality commodities and a decreased 
labour requirement for irrigation.  The ultimate success of the application of this advancing 
technology remains with the water management skill level of the irrigation water user.   

 

3 AIMM - What Is It? 
The Alberta Irrigation Management Model is a software package, designed exclusively for use 
at the farm level to help producers in their irrigation scheduling decisions. The model 
simulates the growing conditions and crop water use of 54 different crops. The software is 
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designed and built not only to serve as a management and record keeping tool for irrigation 
operations but as an irrigation management-training tool as well. 

 
 

4 Output From AIMM 

 

1) Graphical and tabular reports of daily year to date soil moisture conditions, 
evapotranspiration (crop water use), climate data, irrigation application amounts, 
surface run-off and deep percolation for any number of fields or sites within fields. 
 

2) Predictive assessment on crop water requirements and irrigation timing for 
designated near-future time periods. 
 
 

3) Record keeping for crop production information such as fertilizer and chemical use, 
seeding rate, crop yields, pumps and pumping record information, irrigation 
applications, and rainfall. 
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5 Installing AIMM 

AIMM is exclusively a Windows based software application (**There is no iOS version). The 
most recent version of AIMM is available for download at 
https://acis.alberta.ca/acis/imcin/aimm.jsp click on the Download AIMM Software tab. 
Once download is complete, follow the prompts to install the program. The model installs 
to a default directory, but the directory can be changed at time of installation. AIMM 
requires SAP s Crystal Reports Viewer to function properly, both 32-bit and 64-bit versions 
are available as a free download at https://www.sap.com/canada/products/technology-
platform/crystal-reports.html . 

 

6 Menu Toolbar   

6.1 File Tab: 

 

 

Figure 1. Choices under File tab on the main menu ribbon. 

6.1.1 Change Database 

 
Select Change Database if the database is not located in the default directory, or if you 
would like to choose another database.  After clicking on Change Database, a window will 
appear, allowing you to browse to the location of a new database file (e.g., Test.mbd). 
 

https://acis.alberta.ca/acis/imcin/aimm.jsp
https://www.sap.com/canada/products/technology-platform/crystal-reports.html
https://www.sap.com/canada/products/technology-platform/crystal-reports.html
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6.1.2 Create a New Database 

 
Using this function will allow the user to generate a new database file.  AIMM users can 
choose to create either a Microsoft Access database file (*.mdb) or the more recent version 
of Microsoft Access database file (*.adb) which is an abbreviated form of the (*.accdb) file 
extension. Either database file is compatible with AIMM.  
 

6.1.3 Import Weather Data 

 
Generally, the weather files required for AIMM model operation are available by clicking the 

download weather file icon . However, other weather data from stand-alone 
meteorological (Met) instruments in the field or Met data from another provider can be used 
providing they are properly formatted for use in AIMM (See Appendix IV for format 
requirements).  Each field/site combination requires an average meteorological day (AMD) 
file (commonly referred to as long-term normals) and a weather file. 

 

 
Figure 2. Import weather file entry dialog. 

 
To import an alternate weather data file, rather than the default meteorological stations 

available in AIMM, click on the grey radio button  to browse to the file location 
containing the properly formatted (*.txt or *.csv) weather data file and click  Open .  Once 
the data file has been selected and you are back at the  Import Weather File  window, enter 
the  Station Name , the  Station elevation  and the  Year . Once all the fields have been filled, 
click  Import  to load the weather data to the database. 

 

6.1.4 Save as 

 
Selecting Save As . . .  will allow you to save any database changes with the file name and 
file location of your choosing.  You can change the name of the default Test.mdb to a more 
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appropriate name. This is useful particularly if you plan to create several databases over 
multiple years. 
 

 

6.1.5 Model All Fields 

 
AIMM allows the user to model all the fields within the current database by selecting the 
Model All Fields option under the File tab. This option allows users the option to model all 

fields at once instead of modelling each field individually using the run model button . 
 

6.1.6 Preferences 

 
Users can choose whether to send error reports and usage statistics to Alberta Agriculture 
and Irrigation. Error reports help us to identify and fix issues that may occur over time within 
the software. Usage statistics help us to identify what software functionality is used more 
frequently and what parts are not being used. By default, the user preference boxes are 
checked. 

 

 

Figure 3. AIMM user preference window.  

 

6.1.7 Exit 
 
Selecting Exit closes AIMM. 
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6.2 Edit Tab: 

 

Figure 4. Options under Edit tab on the main menu ribbon. 

 

6.2.1 New Field 

 
Selecting New Field adds a new field to the database with the default name New Field.  
After a new field has been created the default field name can be changed from New Field to 
a new user preferred name, enter a new name into the text field next to the Field Name 
identifier.  The new field name will update automatically in the Field window to the left. 
Before saving the new field, you must enter planting date, field area, crop type and system 
type found under the System tab.  
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Figure 5. Window display after selecting New Field under the Edit tab on the main menu 
ribbon. 

 

6.2.2 Copy Field 

 
Selecting Copy Field allows you to copy the field opened in the Field window. Once 
selected Copy Field generates a new field with the same name with the addition (- Copy). 
The new field will also copy existing Sample Sites with a (- Copy) extension. 
 

 
Figure 6. Copy Field under the Edit tab on the main menu ribbon. 
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This feature is beneficial when transferring one field over multiple years. The two things that 
require modifying are the planting date and the crop type as the rest of the field information 
remains static from year to year.   
 

6.2.3 Delete Field 

 
Choosing the Delete Field permanently deletes the selected Field from the database and 
any sample sites associated with the Field. 
 

6.2.4 New Sample Site 

 
Selecting New Sample Site simply creates a new sample site with the default name New 
Sample Site.  A new name may be name given to the sample site by entering an 
alphanumeric name under the Sample Site tab (Figure 7). Each sample site is distinguished 
by a maximum soil root zone depth, an allowable soil moisture depletion value in percent, 
and a soil profile depth which includes profile depth in centimeters and a soil type. Each 
sample site is attached to a Field location. More than one sample site may be added to a 
single Field. This may arise if soil conditions are distinctly different one area of a field over 
another or there are topographic features (highs/lows) that the user would like to identify. 
These sample site differences may require infield irrigation timing and/or volume 
adjustments. 
 

 

Figure 7. Output from New Sample Site tab under the Edit tab from the main menu ribbon. 
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6.2.5 Copy Sample Site 

 
Selecting Copy Sample Site copies a Sample Site and adds it to your Sample Site list below 
the list of Fields on the left-hand side of the main window. Using the drop-down list, select 
which Sample Site is to be copied, then select Copy Sample Site from the Edit tab of the 
main menu ribbon. This will produce an Identical copy of the Sample Site you selected.  
 

 
 

Figure 8. Output from Copy Sample Site under the Edit tab of the main menu ribbon. 

 

6.2.6 Delete Sample Site 

 
Delete Sample Site permanently deletes the currently selected sample site. 
 

6.2.7 Weather Data Server URL 

 
Selecting Weather Data Server URL  allows the user to select a new weather data source 
instead of the default URL http://agriculture.alberta.ca/acis/imcin/aimm/ where AIMM s 
weather data is located. If local weather data is not available, check the Alberta Climate 
Information Service web site https://www.acis.alberta.ca/acis/weather-data-viewer.jsp for 
the weather station nearest to your location.  
 

http://agriculture.alberta.ca/acis/imcin/aimm/
https://www.acis.alberta.ca/acis/weather-data-viewer.jsp
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Figure 9. Weather Data Server URL edit window under the Edit tab of the main menu ribbon. 

 

6.2.8 Proxy Server Settings 

 
If connection to the internet is through a proxy server, it may be necessary to enter the proxy 
server s IP address to download weather data over the internet.  Selecting Proxy Server 
Settings from the edit menu opens a Proxy Server Settings window (Figure 10). Simply enter 
the IP address of the proxy server and click Apply. 
 
 

 
 
Figure 10. Proxy Server edit window under the Edit tab of the main menu ribbon. 
 

6.2.9 Crop Coefficients 

 
 Crop coefficients are used in the model to define how a specific crop uses water 
compared to an alfalfa reference crop. Crop coefficients are unique to the crop grown, the 
reference evapotranspiration equation, and to the climatic area. Crop coefficients used in 
AIMM are calibrated for the semi-arid region of Southern Alberta.  
 Crop coefficients in AIMM use cumulative growing-degree-days (GDD5) as the 
independent axis when constructing the crop coefficient curve. Crop coefficients are 
evaluated and updated using a Bowen Ratio Energy Balance System. New crop coefficients 
are posted on our AIMM website once they become available. It is good habit, once each 
spring, to press the Update All Crop Coefficients icon to ensure the newest crop 
coefficients are available within the current database. 
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Figure 11. Edit crop coefficients options. 

 
If the model is being applied to fields outside of Alberta, the area the crop coefficients were 
calibrated and validated for, the Advanced icon can be used to enter coefficients specific to 
your area of interest. 
 
 

 
Figure 12. Advanced option for crop coefficients. 

 

The crop coefficient equation is in the form of a 4th degree polynomial in the form of  
 

432 exdxcxbxakc ++++=  
Where:   

 

kc  = crop coefficient (dimensionless) 

x  = cumulative growing degree days 

a , b , c , d , e  = coefficients specific to the crop grown (Barley in the example 
above). 
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Once the locally calibrated crop coefficients are entered, pressing the Save New Crop 
Coefficients icon will write the new GDD5 coefficients into the database replacing the 
default coefficients. 

 

6.2.10 Precipitation Gauges 

This selection enables associating multiple fields to local precipitation gauges. For 
instance, if there is a centrally located precipitation gauge for monitoring rainfall events, 
associating fields to the precipitation gauge allows one entry of precipitation to be applied 
to the linked fields, eliminating the necessity for adding rainfall events to each field 
separately. 

 

 
Figure 13. Precipitation gauge addition window. 

When adding precipitation gauges, click New and the gauge name information can be 
added. The field presently being entered will be associated with the current gauge name, 
however if multiple gauges are being used, they will appear in the drop-down menu of the 
Precipitation Gauge selection after entry.  

 

6.2.11 Network Block 

This selection enables organizing multiple fields into blocks. It is a feature specific for fields 
located within an irrigation district where irrigation water is supplied through the districts 
canal distribution system. This helps to organize the information on who to call when a 
water order is placed. 
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Figure 14. Network block dialog entry. 

When entering the information, click on New to add the Block Name, Water Supervisor 
Name and Water Supervisor Email. The current field you are entering the information for will 
be associated with the network block information entered. As more network blocks are 
entered, they will appear in the drop-down menu entitled Network Block. 

 

6.3 Add Tab 

 
Figure 15. Options under Add on the main menu ribbon. 
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6.3.1 Irrigation 

This option allows irrigations to be entered all in one interface without the need for 
highlighting each field in the database. Note: The field must be irrigated with center pivot 
irrigation to use this option. 

For each field enter the gross application per revolution, time per revolution, application 
efficiency (if different than the default values), irrigation date, irrigation time (how long the 
irrigation was applied). The gross irrigation application and effective irrigation application 
will be calculated based on the center pivot operating characteristics, irrigation time and 
application efficiencies. Clicking the APPLY button will add the irrigations entered to the 
irrigation input under the Moisture Tab . 

 
Figure 16. Adding irrigations to multiple fields. 

If a Valley® CAMS panel with the BaseStation software is part of your irrigation system, the 
application data from the BaseStation software in the form of a comma delimited file (.csv 
or .txt) can be entered directly into the Add Irrigation table by selecting the  Load CAM Data 
button . The water report must include the columns listed in Figure 17. The user must 
ensure that the field names from the CAMS output files are identical to the field names 
entered into AIMM program (Figure 16). 

 

 
Figure 17. Example of data output from the Valley™ BaseStation2 software. 

 

If a Valley™ user is using AgSense® for pivot control and monitoring, an AgSense® report 
can be loaded into AIMM by selecting the Load AgSense® Data radio button. As with CAMS 
users the AgSense® user must ensure that the field names within the water report are 
identical to the field names entered into the AIMM program. The water report must include 
the columns listed in Figure 18. This will ensure proper integration into AIMM.  
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Figure 18. Example of data file from the Valley® AgSense® software. 

 

If a Lindsay™ user is using FieldNET® for pivot control and monitoring, a FieldNET® water 
usage report can be loaded into AIMM by selecting the Load FieldNET® Data radio button. 
The FieldNET® user must ensure that the field names within the output file are identical to 
the field names entered into the AIMM program. The water report must include the columns 
listed in Figure 19. This will ensure proper integration into AIMM. 

 

 

Figure 19. Example of data file from the Lindsay® FieldNET® software. 

 

6.3.2 Precipitation 

This option provides for the addition of precipitation events by date to each precipitation 
gauge within the current database. After selecting the Apply radio button all fields 
associated with the precipitation gauge will be updated with the most recent precipitation 
additions.  

 
Figure 20. Adding precipitation amounts from local precipitation gauges. 
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6.3.3. Soil Moisture Measurements 

This option provides for the bulk upload of soil moisture measurements. The upload file 
must be a .csv file, which includes the columns and headers listed in Figure 22.  This option 
allows the user the ability to upload multiple soil moisture measurements without having to 
enter the soil moisture data one at a time. 

 

 

Figure 21. Adding bulk upload of soil moisture measurements. 

 

 

Figure 22. Example of soil moisture file format. 

 

 

Figure 23. Soil moisture measurements are added to the Moisture Tab as illustrated above.  

 

 

6.4 View Tab: 
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Figure 24. View Tab. 

 

6.4.1 Water Management Report 

This selection summarizes the information for all the fields entered in the database into one 
worksheet. Information summarized for each field includes, field capacity (based on soil 
texture), current moisture status, irrigation threshold based on the soil hydraulic properties, 
prediction date, whether an irrigation is required (No – appears in black, Yes – appears in 
red), Water On (check box), Water Order Date, and summaries for the season (Total 
Irrigation, Precipitation and  Total Applied Moisture (summed from irrigation and 
precipitation)), and Last Sample Date (last date of manual soil moisture monitoring). There 
is also a check box for irrigation completion, an over irrigation indicator, planting date and 
finally a last irrigation date. Data can be viewed for the entire root zone (100% Maximum 
Root Zone) or the upper half of the root zone (50% of Maximum Root Zone), by toggling the 
selection at the top right-hand side of the window.  

The irrigation trigger allows for the user to set how much reserve water, above the irrigation 
threshold, to retain in the soil profile while identifying an irrigation is required (data turns to 
red) (See explanation in Appendix 1). 

 

 
Figure 25. Water management summary for all fields and sites. 
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6.5 Reports Tab: 

 
 

Figure 26. Options under Report tab. 

The following options are available under the Reports Menu Option: 

• Chemical Application 

• Fertilizer Application 

• Field Summary 

• Moisture Levels 

• Moisture Inputs 

• Pumping Record 

• Site Summary 

• Soil Analysis 

• Water Orders 

• Water Management 

• Irrigation Summary 

The reports listed above were designed to provide a digital copy of AIMM inputs and model 
results. Once generated, reports can be sent to a printer or exported to a file.   Export 
formats include Microsoft Word, Microsoft Excel and PDF (Figure 26). For more information, 
see section 6.5.1 (Viewing Reports). 
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Figure 27. Report file export formats. 

 

6.5.1 Viewing Reports 

After clicking on the report of interest from the Reports menu, a new window will open 
containing the report.  You can print or export the report in the file formats listed in Figure 
26.  

 
Figure 28. Example report. 

The report can be printed by selecting the printer icon or exported using the disk icon. Both 
icons are circled in red at the top left of the example report (Figure 27).   
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6.6 Help Tab 

The Help Tab opens two options: 1) Open Log Folder, 2) About. 

1) The Open Log Folder  option directs the user to the log files (Figure 28), which 
catalogues error data for use in diagnosing problems within AIMM.  

2) This option contains information on the current version of AIMM, the database 
version, and copyright information (Figure 29). 

 
Figure 29. Help Tab – Open Log Folder. 

 

 
Figure 30. Help Tab – About. 

For more help, please see section 17 Technical Support.  
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7 Getting Started 

 

7.1 General Information on Entering Data 

7.1.1 Conversion Tool 

AIMM uses metric units for all the calculations. On many text boxes throughout AIMM, there 
is a conversion tool available where you can enter data using imperial units and they will be 
converted to the metric units for calculations within AIMM.  For some input parameters the 
calculator is visible on the right edge of the input box (Figure 30). For others you must 
select the input box by clicking it, and the conversion tool will launch.  When launched, 
simply type the value to be entered in the textbox labeled  Convert , and then click on the 
corresponding unit you are entering.  Only units that can be converted are listed below the 
value you just typed in (Figure 31).  When finished, click the  OK  button to complete the 
conversion, or the  Cancel  button to cancel and leave the value unchanged. 

 

Figure 31. Conversion tool – input box and icon. 

 

 
Figure 32. Conversion tool window. 

 

7.1.2 Calendar Tool 

Within several text boxes and grids throughout AIMM, there is a quick pick calendar tool for 
choosing a date.  If you click inside a cell that requires a date the current date automatically 

appears and a   appears to the right of the date. By clicking on the  a blue and grey 
calendar appears (Figure 32).  Once launched choose the corresponding date of interest. 
You can also add a date manually the date format is YYYY-MM-DD.  
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Figure 33.  Calendar tool, embedded in the date input field above. 

7.1.3 Time Picklist 

If you find yourself under the Pump tab, a time picklist is available.  When clicking on 
pumping on/off times a time picklist will appear.  The time picklist displays a 24-hour clock 
in 15-minute intervals. Simply choose the corresponding time of interest in either AM or PM 
for your pump on/off times. For more information on the functionality of the Pump tab refer 
to the  Pump  tab description in section 11.  

 
Figure 34. Time picklist tool. 
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7.1.4 Program Buttons  

 

   

Figure 35. Program buttons. 

 

7.1.4.1 Run Model Button 

Click the Run Model button  to run the current model. 

 

7.1.4.2 Weather Data Button 

Click the Weather Data button  to download weather data from the Alberta Climate 
Information Service (ACIS) web site.  A window will launch, containing all the available 
AIMM meteorological stations available for download (Figure 36).  A single record or 
multiple records may be selected by clicking the check box associated with each station.  
Once all desired records are selected, click the Download button – wait for the download 
complete acknowledgement, and then click Exit.   

If unsure of the nearest regional meteorological station, a map identifying the location of all 
regional stations in Southern Alberta is located at https://acis.alberta.ca/acis/weather-
data-viewer.jsp. 

https://acis.alberta.ca/acis/weather-data-viewer.jsp
https://acis.alberta.ca/acis/weather-data-viewer.jsp
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Figure 36. The Download Weather Data window. 

 

7.1.4.3 Save Button  

Whenever a change has been made, the file needs to be saved. Once saved, a model run 
can be carried out.  It is important to remember that changes must be saved, or the model 
will not run. It is a good habit to click the  button after entering data, and each 
time you move to a new input screen. 

 

7.1.4.4 Exit Button 

Click the  button to leave the program. 
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8 Field Tab 

 
Figure 37. Field tab.   

To create a new Field: 

• Click on Edit, then New Field. Enter the Field Name and click Create Field button. 

• Click on Edit, then New Sample Site. This will take you to the  Sample Site  tab. Enter 
the name (or number) for the sample site and fill in the remainder of the  Sample 
Site  input values refer to 12 Sample Site in this manual for more detailed 
information.  

• Enter the field area as hectares.  If you have the field area in another unit, click on 

the conversion tool .  In the Convert to ha window, enter the numeric value of 
the measurement in the text box, then select the appropriate unit below, then click 
OK.  The conversion tool can convert the field area from acres, square feet, square 
miles, square kilometers or square meters. Please note that area is displayed in 
hectares throughout the AIMM application. 
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Figure 38. Field tab. Conversion tool for area.   

 

• Select the  Crop Type  from the crop type picklist. This is done by clicking on the 
downward arrow on the right side of the input box. This will display all the crop 
options included in AIMM. 

• Enter  Planting Date  by using the YYYY-MM-DD calendar convention or by clicking 

on  and selecting a date from the quick pick calendar option.   

• If entering a field that will be connected to a local precipitation gauge, associate a 

Precipitation Gauge and/or Network Block to the field by clicking the icon to 
the right of the picklist box. This will allow the user to connect multiple fields to one 
precipitation gauge and one network block (block of fields controlled by one water 
master). This input is not necessary if the multiple field option is not being used. 

 

Please Note: For the model to run Field Name, Crop Type, Area, Planting Date, Sample 
Time, and are required inputs under the  Field  tab for AIMM operation. All other inputs are 
optional.  
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8.1 Optional Inputs on the Field Tab 

The following are for information record keeping only and are not required to run the model. 

• Enter the Seeding Rate, then select the picklist box to select units.   

• Enter the value for the Plant Spacing in centimeters or use the conversion tool to 
convert inches or feet. 

• Enter value for the Row Spacing in centimeters or use the conversion tool to convert 
inches or feet. 

• Enter harvest date by using the YYYY-MM-DD calendar convention or by clicking on 

 and selecting the date from the quick pick calendar option. You may add the 
crop yield at end of season and use the picklist for units. Unit options are bu/ac, 
kg/ha, lb/ac, tonnes/ha, and tons/ac. 

• Land location is for record keeping purposes only. 

• Turnout number (only applicable in earlier versions of AIMM). 

 

9 Inputs Tab 

 

 
Figure 39. Inputs tab. 
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Information under this tab is for record keeping and/or information purposes only and not 
used in any model calculations. 

• In the Soil Analysis ,  Fertilizer Applications , or  Chemical Applications  boxes, enter 

a date by using the YYYY-MM-DD calendar convention or clicking on  and 
selecting the date from the quick pick calendar option.   

• For chemical applications enter product rates, water volumes and additives in l/ha 
and litres or launch the converter by clicking in the cell, then clicking on the 

calculator icon , once the converter is open enter the data to be converted and 
select the unit for conversion.  For chemical applications you can also record time, 
windspeed and temperature. 

• Enter kilogram per hectare values in the appropriate fertilizer and soil analysis boxes 
(e.g. N, P, K, S, etc.), or launch the converter by clicking in the cell, then clicking on 

the calculator icon . In the converter, enter the data to be converted, select the 
unit for conversion. Under the soil analysis and fertilizer applications pounds per 
acre is the only option for unit conversion.  

• Additional information can be added in the comments section (climatic variances 
etc.) 

 

10 System Tab 

 

Figure 40. System tab. 
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10.1 System Type 

 

 
 

Figure 41. System Type. 

 
Select the System Type from drop down box.  Default values have been developed for each 
method of irrigation.  If specific irrigation system information is available, this can be 
entered into any box in the Input Parameters section. To choose different units for System 
Capacity and Length of Pivot launch the conversion tool by clicking in the cell and then 

clicking on the calculator icon .   

• The default value for Application Efficiency can be over-written with a new (or 
known) value. 

• When all the boxes in the Input Parameter section have been filled, select the 
Calculate button at the bottom right-hand corner of the System tab.  This will 
populate the remaining three boxes in the Calculated Values section.  
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11 Pump Tab 

 

Figure 42. Pump tab. 

Input under this tab can be used for the addition of irrigation applications, which are 
applied based on pump on-off times. 

• Select the date range the pump will be active under the corresponding headings of 
Date On, Date Off.  Enter the date enter a date by using the YYYY-MM-DD calendar 

convention or click on  and select the date from the quick pick calendar option 
for both Date On and Date Off  boxes.   

• Select the time interval the pump will be active under the corresponding headings of 
Time On, Time Off  using the quick pick time selection tool.  

Accumulated Hours, gross application (mm), and effective application (mm) are automatically calculated.   

Gross irrigation and effective irrigation are calculated based on the irrigation system 
information from the Systems tab. The calculated gross and effective irrigation applications 
can be added to the Moisture Input grid under the Moisture tab by clicking the button to the 

right of the input boxes . A window confirming (Figure 43) an irrigation has been added 

to the Moisture inputs tab for the current sample site will appear after clicking the  
button. 

 

 

Figure 43. Pump tab irrigation addition confirmation.  
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12 Sample Site 

 

 
 

Figure 44. Sample Site tab.   

The input boxes under the Sample Site tab must be completed for proper operation of the 
model. 

• The Sample Site text box is the name of the sample site to be used, from the 
corresponding Field (see Field Tab). 

• The Maximum Soil Root Zone Depth (m) is by default set to one meter. You can enter 
your own value in meters based on the rooting depth of your crop or you may launch 
the conversion tool to enter a value in inches or feet.   

• The Allowable Soil Moisture Depletion (%) is a default value that you can modify by 
selecting your own value. The lower the soil moisture depletion the lower amount of 
water that is depleted from your soil moisture profile before requiring irrigation. See 
Management Allowed Depletion in Appendix III for more information. 

• Soil Profile 

1. Profile Depth - The user may add as many incremental depths as they 
believe representative of their soil sample site location, but the total of the 
profile depths must match the maximum soil root zone depth.  
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2. Soil Type - Soil type for each incremental depth must be classified by a soil 
type. Soil types can be selected by opening the picklist under the Soil type 
column. (See Appendix III for a flow chart to determine soil texture.) 

• Once both a profile depth and associated soil type are entered the following 
columns,  mm of Available Water at 100%  and  mm Of Water at Wilting Point , will 
be populated based on the soil type selected.  

• After all profile depths and associated soil types are entered, the radio 

button must be clicked. After clicking the  button the  Total Available 
Moisture  and  Allowable Depletion  columns under the Available water portion of 
the  Sample Site  tab will be populated.  

• Under  Sample Site Comments , enter any comments as needed. 

• Save your changes before moving on to the next tab.  

 

13 Moisture Tab 

 

Figure 45. Moisture tab. 
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Soil moisture must be measured at least once at the start of the season to identify a starting 
soil moisture value for model simulations (See Appendix III, Figure III-3 for a flow chart to 
determine soil moisture using the hand-feel method).  

• Clicking on the  radio button (Figure 45) will open a second window (Figure 
46).  Soil moistures values can be added in either % Available or by % Volume 
(Figure 46). Soil moistures can be entered for each soil profile depth in the 
Measured Moisture table. To aid in determining how much soil moisture is available 
by percent refer to Appendix III Table III-2. 

 
Figure 46. Converting percent soil moisture to millimeters. 

• Once the first soil moisture reading has been added, measured soil moisture data 
can be entered throughout the season to check on model accuracy or to correct 
model predictions (Figure 36). If you want to use Measured Soil Moisture readings, 

the box must be checked, which is in the middle of the 
Moisture Tab page.  Otherwise, the modeled soil moisture values in Figure 45 will be 
used.   

• For the moisture inputs for the Current Sample Site, the date can be either entered 

manually or by clicking the  button to open the calendar and select the current 
date.  

• The bottom half of the page with the heading Moisture inputs for Current Sample 
Site gross amounts of water applied can be added (Figure 45). These are irrigation 
amounts that are applied without considering the efficiency of the irrigation system 
applying the water. Check the System Tab if you are unsure of the gross application 
amount for your system. 
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• Effective irrigation application is calculated by multiplying the Gross Irrigation 
Application by the  Application Efficiency  (Figure 40). If you have made a change to 
the application efficiency value in the Systems tab, make sure to click on the 

 radio button. Clicking this radio button recalculates the effective irrigation 
application amounts based on the new application efficiency.  

 
 

13.1 Precipitation Inputs 

Rainfall amounts can be obtained either from local precipitation gauges (See 5.2.10 

Precipitation Gauges and 5.3.2 Add Precipitation) or local weather stations.  The  
radio button opens the current weather file, where you can select dates when rainfall 
occurred (Figure 47). A range of rainfall events can be selected by clicking the least recent 
rainfall event, and then while holding down the Shift key, click the most recent rainfall 
event.  You can also select multiple rainfall events by holding down the Ctrl key and clicking 
on the rainfall events using the right button on the mouse. After all the dates you are 
interested in have been selected click on the Add to Moisture Input Grid button to populate 
the rainfall column. 

 

Figure 47. Adding rainfall using the  button under the  Moisture  tab. 
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14 Model Tab 

 
Figure 48. Model tab. 

 

• Select the appropriate Weather Data (year and location) from drop down box. If 
unsure of the nearest regional meteorological station, a map identifying the location 
of all regional stations is located at https://acis.alberta.ca/acis/weather-data-
viewer.jsp. 

• To add  Weather Data  options to the current list of meteorological stations in the  

Weather Data  picklist, click on the Retrieve Weather Data icon   on the 
bottom left hand side of the main window in AIMM. Next select the 
location/locations you are interested in and click on the download button at the 
bottom of the window (Figure 49). 

https://acis.alberta.ca/acis/weather-data-viewer.jsp
https://acis.alberta.ca/acis/weather-data-viewer.jsp
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Figure 49. Download weather data window. 

 

• The  Weather Data Start Date  and  Weather Data End Date  are taken from the 
weather file and do not need to be adjusted. 

• Enter the interval you wish to predict soil water depletion in the  Prediction Days  
text box. The most common suggestion is 7 days in advance. It is advised not to 
choose a prediction date no further than 14 days ahead. 

• AIMM s prediction of crop water use is based on a healthy crop, free of disease, 
actively growing and full canopy coverage. If the user finds the model over-
predicting soil moisture depletion, evapotranspiration can be reduced by a 
percentage. Two examples of where this is used is for hail damage or poor 
germination. Click Apply Water Use Corrections and fill in the date and the 
percentage of the reduction (Figure 50). 

• In the  Water Use Correction for Sample Site  section, enter a date using the YYYY-
MM-DD format or by double clicking on date box, and then clicking on the calendar 

tool icon  and selecting the appropriate date.  
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• Under  Water Use % , you can enter any number from 0 to 100. Once the reduced 
percentage is applied you must select the Apply Water Use Corrections check box 
at the bottom of the page. 

• Water use correction example – on July 1, 2024, had a hail event that reduced plant 
populations by 25%. Water use will not be optimum for a while so reduced water 
use to 75% of optimum on that date. If the crop recovers and it is expected crop 
water use has recovered, can change the water use percent back up to 100% at a 
later date, August 1, 2024, in Figure 50. 

 
Figure 50. Applying water use corrections. 

• Once all the inputs have been entered, click the  Save  button and then the  Run 
Model  button. 
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15 Table Tab  

  
Figure 51. Options for output under the  Table  tab 

• Select either  Model Results  or  Weather Station Data  from drop down box to view 
the selected data in the tables (Figure 51). 

• Tables can be either printed or exported as a .txt or .csv file.  When exporting a file, 
be sure to name the file and select the directory where the data is to be stored. 
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16 Graphs Tab 

 

Figure 52. Options for output under the Graphs tab. 

• Select the graph to be viewed from drop down menu there are thirteen options to 
choose from; moisture balance at 100% and 50% of the maximum root zone (MRZ), 
current moisture level in 100% and 50% of the MRZ for all sites, and a list of 
meteorological data from the weather station selected in the  Model  tab.   

• The  Start  and  End  buttons allow you to look at specific segments within the graph.  

When you click  Start , a calendar icon  opens and you can select a start date for 

viewing data.  Similarly, selecting  End  launches a calendar icon  and you can 
select an end date for viewing data.  The start and end date must be within the first 
and last day of the weather file. 

• Graphs can be printed or exported as a .png files.  When exporting a graph be sure to 
name the file and select the directory to where the data is to be stored. 

• Note: If you left click anywhere on the crop-water-use line, the exact date and soil 
moisture value in (mm) will be displayed in a yellow text box. 

• Note:  See Appendix V for interpretation of each of the graphs. 
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17 Technical Support 

If you are experiencing difficulties downloading climate data or a problem with the AIMM 
software contact:  

Len Hingley @ (403) 362-1343 – leonard.hingley@gov.ab.ca 

Copyright 2025. Alberta Agriculture and Irrigation. All rights reserved. 
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18 APPENDIX 1 

 
50% MRZ - calculates soil moisture based on the upper 50% of the root zone. (Table 1 in 
Appendix III) 

100% MRZ - calculates soil moisture based on 100% of the root zone. (Table 1 in Appendix 
III). 

Plant Available Moisture – the quantity of moisture available for plant use (see explanation 
in Appendix III). 

Average Meteorological Day (AMD) – a weather set containing mean daily values for an 
entire year. Based on an average of daily values for the total years of record for the station. 
If the station does not have multiple years of records, the nearest meteorological station 
with multiple years of records is used.  

Corrected to Measured Soil Moisture – if this option (Moisture Tab) is selected for the 
current sample site, the model will be corrected to the measured soil moisture values on 
the days for which measured values exist.  

Crop Coefficients – are a function of crop characteristics, rate of crop development, 
length of growing season, climatic conditions, the time of planting, and the available soil 
moisture.   

Crop coefficients must be adjusted to account for available soil moisture.  Potential 
Evapotranspiration (PE) is reduced when the soil moisture level is not at capacity.  PE is 
modified by the ratio of the logarithm of the remaining soil moisture to the maximum 
available to the crop in the root zone.  Minimum Kc value has been set to 0.1.  The crop 
coefficient equations used in this model were obtained from Agriculture and Agri-Food 
Canada publications, (Foroud and Hobbs, 1983, Foroud and Beke, 1981). 

Correction for Soil Moisture (Buchleiter et al. 1988)  

0.101log

0.1100log 







+










=
AWM

AW
Kc

Kca  

where aKc = crop coefficient adjusted for available soil moisture 

Kc = crop coefficient 

AW = soil water remaining in profile (mm) 

AWM = maximum soil water available to crop within the root zone of a given soil 
type (mm) 

 

Date Off – the day when the irrigation system is turned off. 
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Date On – the day when the irrigation system is turned on. 

 
Deep Percolation – any water (irrigation and rainfall) that moves below the root zone and 
becomes unavailable for crop use.  This water is considered lost.  Water movement is 
calculated in two phases: 
 

1. In the first phase, if the amount of irrigation and rainfall is greater than the 
water holding capacity of the upper zone, water percolates from the upper 
zone into the lower zone. The amount of water above field capacity is added to 
the lower zone. 

2. In the second phase, if the amount of water added is greater than the water 
holding capacity of the lower zone, water will then move out of the lower zone. 
Water that moves out of the lower zone is considered lost from the root zone 
and is accounted for as a percolation loss. The model allows the root zone to 
exceed the field capacity by 10% in consideration of saturated hydraulic 
conductivity (Shayya et al. 1991). 

 

Elevation – the elevation of weather station above sea level in meters. 
 

ET (evapotranspiration) – the loss of water from the earth s surface through the combined 
process of evaporation and transpiration.  

 
Field Capacity – refers to water content in a field soil after the drainage rate has become 
negligible. 
 

Gross Irrigation Application - the total amount of water applied by an irrigation system. 
 

Growing Degree Day (GDD5) –the average daily temperature minus the base temperature (50C) 

( )
5

2
−







 +
=

MinTempMaxTemp
GDD  

If the minimum temperature is below 0oC, GDD = 0 

Harvest Date – the date at which the crop has been cut, swathed, or desiccated. Can be 
specified by user in the field tab or can be left blank and the harvest date will then be set to 
the last day of the growing degree/crop coefficient curve.  The user must specify harvest 
dates for any forage crop (alfalfa, barley silage under seeded, grass hay, brome hay, tame 
pasture, timothy hay, milk vetch, grass seed, and turf sod). 
 

Irrigation Threshold – is a percentage of the total available water that can be used by a 
crop, prior to starting irrigation – often referred to as management allowed depletion. 
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Irrigation Trigger – used in the Water Management table under View – Water Management 
in the menu toolbar. The irrigation trigger is set as a percentage above the irrigation 
threshold to facilitate notification for water delivery providers. Trigger level is determined 
by: 
  

( )
100

ueTriggerValThresholdIrrigationityFieldCapac
ThresholdIrrigationelTriggerLev

−
+=  

 
Example: Field Capacity – 250 mm, Irrigation Threshold – 125 mm, Trigger Value 10. 

( )
mmmmmmelTriggerLev 5.1375.12125

100

10125250
125 =+=

−
+=  

The data line would turn red (requiring an irrigation) when the profile still has 12.5 mm 
moisture above the irrigation threshold or management allowed depletion. This allows the 
irrigator to arrange for water delivery or start the irrigation prior to reaching the irrigation 
threshold. The higher the irrigation threshold is set, the more water is retained in the profile 
prior to the data line turning red indicating irrigation is required.  

 

Lost Precipitation – surface runoff from a rainfall event. Determined by maximum soil 
water storage of soil profile. 
 

Lower Root Zone Moisture Use – percentage of water extracted from the lower half of the 
root zone.  See  Upper Root Zone Moisture Use  for reference.   
 

Management Allowable Depletion - a percentage of the total available water that can be 
used by a crop, prior to starting irrigation (See explanation in Appendix III).   

Maximum Relative Humidity - maximum daily relative humidity (%) measured at 1.5 m 
above natural ground level. 
 

Maximum Root Zone Depth – effective rooting depth (m) of a mature irrigated crop. 

  
Maximum Temperature - maximum daily temperature (°C) measured at 1.5 m above 
natural ground level. 
 

Measured Soil Moisture – measured amount of soil moisture (mm, VWC%, AWC%) 
present in the field. 
 

Minimum Relative Humidity - minimum daily relative humidity (%) measured at 1.5 m 
above natural ground level. 
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Minimum root zone depth - depth to which a crop is seeded (cm). 
 

Minimum temperature - minimum daily temperature (°C) measured at 1.5 m above natural 
ground level. 
 

Model Start Date – the first day a measured soil moisture reading is entered into the model.  
It is recommended that a soil moisture measurement be taken at the time of seeding.  Crop 
consumptive use is calculated from the time of the first soil moisture reading to the harvest 
date. 
 

Modeled Moisture - amount of moisture present in the field as determined by the model. 
 

Net Irrigation Application - the amount of moisture that is added to the soil. 

Net Irrigation Application = Gross Irrigation Application × Efficiency Ratio 

 
Operating Capacity – flow rate of the irrigation system. 
 

Operating Pressure – normal pressure at which the irrigation system is operated.  
 

Operating Speed - speed at which the pump is operated.  
 

Over-irrigation – any excess irrigation applications received, above what can be accepted 
beyond the 110% of field capacity limits, in both the upper and lower root zone. 
 

PE Equations – the model currently uses the Priestley-Taylor and Modified Penman 
equations for calculating potential evapotranspiration.  The Priestley-Taylor equation 
should be used when no wind data is available. 

Priestley-Taylor: 
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=    (Jensen et al. 1990) 

Where:  

α = calibration constant 
 = slope of the saturation vapour pressure-temperature curve in kPa/°C 
   = psychrometric constant in kPa/°C 
   = latent heat of vaporization in MJ/kg 
 Rn = net radiation in MJ/m2/day 
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 G = soil heat flux in MJ/m2/day 

 

Modified Penman: 

𝐸𝑇𝑟 =
(0.408×Δ×(Rn−G))+(γ×(

1600

(T+273)
))×u2×(es−ea)

(Δ+(γ×(1+(0.38×u2))))
   (ASCE 2005) 

 
Where:  
 

ETr = ET for tall reference crop evapotranspiration (mm day-1) 
 = slope of the saturation vapour pressure-temperature curve (kPa °C-1) 
 Rn = net radiation in (MJ m-2 day-1) 
 G = soil heat flux in (MJ m-2 day-1) 
  = psychrometric constant (kPa °C-1) 

T = mean daily temperature (°C) 
es = saturation vapour pressure (kPa) 
ea = actual vapour pressure (kPa) 
u2 = wind speed at 2 m height (m s-1) 

This equation uses alfalfa as the reference crop. 
 

Planting Date – used to establish when the growing degree day/crop coefficient curve is to 
begin.   
 

Potential Evaporation (PE) – maximum amount of water that a crop can use.  Generally 
determined daily.  Theoretical equations are generally used to calculate PE.  
 

Precipitation - to simplify how water moves in the soil profile, the assumption is made that 
whatever falls as rainfall (< 25mm) is 100% applied. The following is the criteria used for 
determining rainfall runoff (when rainfall is >25 mm): 

Rainfall Events > 25mm (1.0 Inch): Infiltration (I) 

 𝑅𝑢𝑛𝑜𝑓𝑓 = Rainfall (𝑅) − Infiltration (𝐼) 

 𝐼 = 0.9177 + 1.811 × (𝑙𝑜𝑔 𝑒 𝑅) − 0.0097 × (𝑙𝑜𝑔 𝑒 𝑅) × (
𝑆𝑀

𝐹𝐶
) × 100   

(Baier and Robertson 1966) 

Where:  

 R  = Rainfall (inches) 

SM  = Soil Moisture (inches).  Available soil moisture in the root zone at the end of 
day i-1, that is, at the morning observation of day i. 
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 FC  = Field Capacity (inches) 
 

Prediction of Next Irrigation – forecasting of the next irrigation is based on end of current 
weather and the number of prediction days entered.  If the soil moisture level drops below 
the irrigation threshold prior to the end of the weather file, the next irrigation will be set for 
the first day of the selected prediction day.  If the soil moisture level remains above the 
irrigation threshold, the model will predict only to the number of days selected, and an 
irrigation during this time may not be forecast.  
 

Root Zone Transition Date – the number of days after planting date required for the roots of 
a plant to enter the lower 50% of the maximum root zone.  Dependent on crop type. 
 

Soil Evaporation Loss – after harvest, water lost from the soil profile is set to a growing 
degree day/crop coefficient of 0.1 until end of the weather file. 
 

Soil Name/Soil Type – texture of soil layer. 
 

Soil Profile Depth – depth of soil layer. 
 

Solar Radiation - incoming short-wave radiation measured at 1.5 to 2 m above natural 
ground level.  
 

Station Name – location of weather station. 
 

Time Off – the time when irrigation system is turned off 
 

Time On – the time when the irrigation system is turned on 
 

Total Available Moisture – is the amount of water that is held between field capacity and 
wilting point.  Allowance has been made for the soil moisture to exceed field capacity by 
10%.  If the soil moisture is > 10% of field capacity, it is set it to 1.1* field capacity, with the 
excess water then lost to deep percolation. 
 

Upper Root Zone Moisture Use – percentage of water extracted by roots in the upper 
portion of the root zone.  (Pair, 1975)     
 

Water Use % - default is 100%.  Setting this to 100% represents no adjustment to ET.  Any 
value less than 100% will reduce ET by that percentage.  No value in the box means that 
there is no reduction to ET, same as 100% setting. 
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Weather Data – model requires daily maximum and minimum temperature, incoming solar 
radiation, wind travel, maximum and minimum relative humidity, and rainfall.  If weather 
data from a source other than regional meteorological stations are available, they can be 
used in the AIM model. Weather files use a comma separated file format (.csv) and can be 
created or edited using most spreadsheet programs.    
 

Wilting Point – is the soil water content below which plants growing in that soil remain 
wilted and do not regain turgor. 
 

Wind - collected as wind run at 2 meters above natural ground level.  If wind is collected at 
any other height, it can be adjusted using the wind power law:  

a

Z

Z
WW 








=

1

2
12    (Jensen et.al., 1990) 

Where: 

                1W  = measured wind at height Z1 (m/s)  

2W  = estimated wind at height Z2 (m/s) 

1Z  = measured wind height (m) 

2Z  = estimated wind at 2 m 

 a = constant of 0.2 (Jensen 1974) 
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19 Appendix II 

Equations and Constants for Evapotranspiration Equations  

α - calibration constant = 1.70 

γ - psychometric constant 
( )

( )


=
622.0

Pcp
, kPa / ° C 

Δ - slope of the saturation vapour pressure-temperature curve 

   ( )( )( )( ) 00116.08072.000738.0200.0
7

−+= T , kPa/ ° C 

λ - latent heat of vaporization ( )T−= 00236.0501.2 , MJ/kg 

cp - specific heat at a constant pressure = 0.001013, MJ/kg/ ° C 

P - atmospheric pressure  
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Rn - net radiation 
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Rs - total incoming solar radiation, MJ/m2 

G - soil heat flux = 0, MJ/m2 day 

U2 - wind speed at 2m, m/s 
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2U
, wind travel, km/day 

T - mean daily temperature 

T 






 +
=

2

minmax TT
,  °C 

(ea-ed) - mean daily vapour pressure deficit 

Sat(vp) ( )







−








−= TK

TK
ln03.5

5.6790
58.52exp  

Daily(vp) 
100

RHmeanSatvp
=  

Vpd DailyvpSatvp−= , kPa 

TK 273+=T , °K 

H - elevation, m 
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20 Appendix III 

Total Available Moisture  

Soils can hold water against the force of gravity due to soil matric potential or soil water 
tension. Therefore, even in situations where water is free to drain out of the root zone, a 
significant portion of the water will be held due to soil water tension. The amount of water 
held in the soil profile against the force of gravity after drainage is called field capacity.  

 

The qualitative definition of field capacity is the maximum amount of water a soil profile can 
retain provided the profile is able to drain freely (no impeding layer of bedrock or water table 
within the profile). The quantitative definition of field capacity is the water retained in a soil 
sample after subjecting the sample to a negative pressure of –33 kPa (-10 kPa for sandy 
textured soils). 

 
Plant roots extract water from the soil for photosynthesis and to retain turgor or stem and 
leaf strength and structure. As the soil dries, the water remaining in the soil is bound more 
tightly to the soil particles or tiny spaces within the soil matrix and can no longer be taken 
up by plant roots. When the plant roots can no longer extract water from the soil they wilt 
and eventually, if denied water, will die. At the point where the plant can no longer recover 
turgor once wilted, it is said to have reached its permanent wilting point. The quantitative 
definition of permanent wilting point soil moisture is the amount of water remaining in a soil 
sample after the soil is subjected to a suction of -1500 kPa. Permanent wilting point is an ill-
defined concept since plants differ in their abilities to extract water from soils.  Soil water 
between field capacity and wilting point is termed plant available water; available for plant 
roots to absorb for photosynthesis and transpiration (Figure III-1). Soil texture is the 
dominant soil feature that determines how much available water the soil can hold (Table 
IIII-1). 

 

 

Figure III-1. Plant available moisture between field capacity and wilting point. 
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Soil Texture Available moisture per 
25 cm soil depth 

Wilting point (mm of moisture per 
10 cm of soil depth 

Loamy Sand 28 6 

Sandy Loam 35 8 

Loam 45 13 

Sandy Clay Loam 38 12 

Silt Loam 50 11 

Clay Loam 50 16 

Silty Clay Loam 55 19 

Sandy Clay 43 22 

Silty Clay 53 22 

Clay 48 22 

Fine 52 25 

Medium 45 16 

Coarse 30 6 

Table III-1. Available moisture for various soil textures. 

 

Management Allowable Depletion 

The extent an irrigator allows the available soil moisture to drop before irrigating depends 
on the crop grown and the irrigation system used. For most grain, oilseed and forage crops 
irrigated using surface or wheel move, the suggested management allowable depletion 
(MAD) is 50%. Management allowable depletion, for the same crops using centre pivot 
irrigation is 30%. The suggested management allowable depletion for potatoes is 30%. 
Some crops, such as sugar beet, alfalfa seed and chickpea require some soil moisture 
stress to maximize sugar content or encourage flowering for maximum pod development. 
The management allowable depletion will change throughout the irrigation season for these 
crops. Management allowable depletion in percent is displayed on the Y axis on the right-
hand side of the graph, while available soil moisture in (mm) is displayed on the Y axis on 
the left-hand side of the graph (see Figures III-2a & b). 
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Figure III 2(a). Management allowed depletion set to 50%. 

 

 
Figure III 2(b). Management allowed depletion set to 30%.
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Figure III-3. Hand-feel determination of soil texture. 
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Figure III-4. Soil textural triangle. 
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Table III-2. Hand-feel determination of available moisture for differing soil textures. 
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21 Appendix IV 

Weather File Format 

The weather file must be comma delimited (.csv) file in MS Excel and have the headings and 
data arranged in the format as shown below: 

Year,Month,Day,TMAXC,TMINC,WINDKMD,PRECMM,RHMAX,RHMIN,SRKJD 

2001,4,1,11.9,-3.8,314.5,0,92.5,32,16848 

2001,4,2,8.9,-5.7,205.8,2.2,99.8,53.7,9590 

2001,4,3,0.7,-2.4,214.5,0.8,106.3,77.5,8122 

2001,4,4,3.4,-3.7,365.1,1,106.3,57.7,19354 

2001,4,5,11.5,-4.2,481.9,0,95.8,38.3,20736 

2001,4,6,12.6,-1.5,230.5,0,100.7,33,15984 

2001,4,7,14.8,-4,216.2,0,103.2,32.9,19958 

2001,4,8,13.1,0.7,227.1,0,97.2,34.9,16416 

2001,4,9,12.9,-4.9,180.2,0.2,103.5,40.2,20822 

2001,4,10,6.9,-0.1,327.6,0,103.6,41,11059 

2001,4,11,5.2,-3.8,193.8,0,96,44.5,18144 

2001,4,12,5.7,-5.4,384.5,0,104.9,60.3,9245 

2001,4,13,13,-5.9,351.4,0.2,106.6,17.2,18662 

2001,4,14,7.6,-3.2,184.7,0.2,98.6,40.5,10627 

2001,4,15,4.4,-6.2,225.2,0,91.8,39.8,15293 

 

TMAXC – maximum temperature in (oC) 

TMINC – minimum temperature in (oC) 

WINDKMD – wind speed in (km per day). 

PRECMM – daily precipitation (mm) 

RHMAX – maximum relative humidity (%) 

RHMIN – minimum relative humidity (%) 

SRKJD – incoming short-wave solar radiation (kJ per day) 
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22 Appendix V 

Interpretation of the Graphical Output 

 
Figure V-1. Graph of moisture balance, 0-100% of maximum root zone. 

• In Figure V-1 and Figure V-2 the irrigator should work at keeping available 
soil moisture (black line) between the two parallel blue lines. The top blue 
line represents field capacity (100% of available soil moisture), and the 
bottom blue line is set at 70% of field capacity or 30% manageable allowed 
depletion (MAD).  

• When the solid black line peaks above field capacity water is either lost to 
run-off, ponding, or deep percolation. When the soil black line dips below 
MAD water should be applied by the irrigator to maintain optimum crop water 
use.  
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Figure V-2. Moisture balance, 0-50% of maximum root zone. 

 

 
Figure V-3. Graph of current soil moisture level in maximum root zone. 
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Figure V-4. Graph of accumulated evapotranspiration (crop water use). 

 
Figure V-5. Graph of daily evapotranspiration (crop water use). 
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Figure V-6. Graph of daily rainfall amounts. 

 
Figure V-7. Graph of daily maximum and minimum temperature in Celsius. 
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Figure V-8. Graph of lost precipitation or over irrigation in (mm). 

 

 

Figure V-9. Average wind speed in (km/h). 
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Figure V-10. Maximum and minimum relative humidity in (%). 

 

 

Figure V-11. Solar radiation (kJ/m2/day). 
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Figure V-12. Example of AIMM output graph – a guide to interpreting your graph. 
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